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Introduction 
 
Microsoft Excel is a program with great opportunities. The 
normal user only uses a fraction of its possibilities. The 
individual use depends on which tasks your daily work involves. 
These tasks can be executed in many different ways using Excel. 
One way is not necessary better than the other; there are 
however certain tasks that can be executed with greater or lesser 
efficiency. 
 
This essay reflects my personal way of working with Excel. I 
am still learning new functions and ways of working. Due to the 
fact that this essay does not necessarily show the most optimal 
ways, some people who read the essay may have different 
background and experience, and they might have better 
solutions. Moreover, that is just the fascinating thing with Excel 
- a continuous development of knowledge and skills. 
 
This essay is neither a basic education nor an advanced course. 
It is just my recommendations about how Excel can be used 
with greater efficiency. Many of my ideas are based on my 
experience of working with excel tables created by other users. 
 
 

Basic efficiency 
 
Quick access toolbar 
 
In a new installation of Excel, the quick access toolbar is 
showed above the ribbon. The toolbar only includes 
 

• Save 
• Undo 
• Repeat 

 
 
Verktygsfältet snabbåtkomst (Swedish) 
 
Symbolleiste schnellzugriff (German) 
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By clicking on the drop-down list to the right of the toolbar a 
menu for customizing it is shown. Some commands may be 
chosen directly from the menu, others can be chosen after 
selecting “More Commands…”. 
 
 

 
 
 
My recommendation is to include all the commands that are 
shown directly on the menu. The most efficient way of using the 
quick access toolbar is to include all the commands that you use 
frequently. It is also recommendable to show the quick access 
toolbar below the ribbon, where it is more visual. 
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Right mouse button 
 
The right mouse button includes shortcuts to commands that 
Excel finds appropriate for the specific situation. By clicking on 
the right mouse button a menu drops down with the alternatives.  
 
 

 
 
 
 
The keyboard 
 
The keyboard is the fastest and most ergonomic shortcut to 
many commands. The commands are in most cases applicable to 
other office-programs. 
 
 
Ctrl + 
 
N New Excel Workbook 
 
O Open 
 
S Save 
 
P Print 
 
C Copy 
 
X Cut 
 
V Paste 
 
A Mark the whole worksheet or table 
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B Block letters (F if Swedish or German program)* 
 
I Italic (K if Swedish or German program)* 
 
U Underline* 
 
Space Mark a column   
 
+ Insert a new cell, row or column 
 
- Delete a cell, row or column 
 
Home Takes you to the top left cell 
 
End Takes you to the bottom right cell 
 
↑ To the top of the column 
 
↓ To the bottom of the column 
 
→ To the right side of a row 
 
← To the left side of a row 
 
Page Up Previous worksheet 
 
Page Dn Next worksheet 
 

 Next workbook 
 
 
* On German keyboards the “Ctrl” key is called “Strg”. In 
order to obtain block, italic or underlined characters in a 
German office-program, the touch on the “Strg” key must be 
combined with a touch on the “umschalt” key. 
 
 
 
Alt + 
 

 Next program 
 
When the [Alt] key is activated small images appear in the 
menus that indicates which key to touch together with Alt to 
show or change to a different menu. Which sign that is shown in 
the menu depends on which language that is used. The signs 
below show the English version of Excel. To find out the signs 
for your installation just touch the [Alt] key. 
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Alt + 
 
F Shows the Office menu 
 
H Changes to the Home menu 
 
N Changes to the Insert menu 
 
P Changes to the Page-layout menu 
 
M Changes to the Formulas menu 
 
A Changes to the Data menu 
 
R Changes to the Review menu 
 
W Changes to the View menu 
 
X Changes to the Add-ins menu 
 
 
 
Shift + 
 
Space Mark a row 
 
 
 
Work and think “Database” 
 
The most efficient way of working with information in a table in 
Excel is to think in a database mode. When you create  a new 
table with information create it as a database. This means that 
there should be no gaps in the row or columns. The information 
must come in a continuous flow. Do no bother with the layout in 
the beginning of work. Leave this to the end. The important 
thing is which rows (records) and columns (fields) the table 
should include. The main item (primary key) should be placed at 
the left side of the table. When all items are updated think about 
the layout and formulas. Then use the predefined layout and 
formulas in Excel. 
 
It is recommendable to start the table some rows down on the 
worksheet (e.g. row 11). This gives the possibility of inserting 
information above the table. You can for instance place 
formulas above the important columns. 
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Freeze panes 
 
When you work in a table, lock the window under the headline. 
If some information to the left in the table contains basic 
information, place the lock to the right of the basic information 
 
 
Lås fönsterrutor Fenster fixieren 
 
 
 
Filter 
 
It is also recommendable to insert filters on the headline row. 
This enables you to show selected parts of the table. Increase the 
row height when you use filters. If you double the height and 
align the text to the top of the cells, the filters will not hide the 
text in the cells. Together with subtotal formulas you can obtain 
information quickly about selected areas if filters are used. 
 
 
 
Use existing information 
 
There is a phrase that says “Do not invent the wheel again”. This 
also applies to Excel. If you want to use new information 
together with information that already exists, do not spend time 
registering the existing information again. Instead use formulas 
to collect the information from the existing Excel sheet to the 
new sheet. Suitable formulas for this are presented below in the 
section regarding formulas. 
 
 
 
Subtotals 
 
Subtotals can be used either within a table or above/below the 
table.  
 
 
Within a table 
 
When subtotals are used within a table the data must be sorted 
according to the principal columns. For a property company this 
might be country, region, municipality and property name. It 
might also be country, company, bank, loan type, loan number 
etc. Subtotals must be inserted in the order of the importance of 
the principal columns.  Subtotals can be inserted for counts, 
average, minimum, maximum, sum etc. When the subtotal for 
the most principal column is inserted continue with the second 
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(third, fourth etc) important columns. The second subtotal 
should be inserted without replacing the current subtotals 
 

 
 
 
Do not forget that the data must come in a continuous flow of 
columns and rows. 
 
 
 
Above/below a table 
 
Subtotals above/below the table are used together with filters on 
the headline row of the table. The data does not require to be 
sorted in any specific order. When the filter is used in a specific 
column, the result of the filtration is showed by the formula. 
 
 
Subtotal(#;area)  
 
The sign # should be replaced by a number. It then represents a 
certain calculation of the subtotal. The most common numbers 
are 
 
Subtotal 1 Counts the average of selected items 
 
Subtotal 3 Counts the number of selected items 
 
Subtotal 4 Selects the maximum value of the selection  
 
Subtotal 5 Selects the minimum value of the selection 
 
Subtotal 9 Sums the selected items 
 
 
When the headline is combined with filters and frozen panes it is 
recommendable to insert the subtotal formulas above the table. 
The advantage of this is that the formulas always will be visible. 
 
Delsumma Teilergebnis 
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Auto adjusted column width and row height 
 
To get the exact width for a column double-click on the right 
borderline for the column on the headline row (A, B, C etc). 
 
This may also be adopted on the row-height, but is more useful 
for the column width. 
 
If you would like to auto adopt the row-height. Double-click on 
the borderline under the number on the row number column. 
 
 
 
Formulas 
 
 
Basic formulas 
 
 
Right =Right(Cell;#) 
 

Show the # number of signs counted from the right 
side of the indicated cell. 

 
 Höger  Rechts 
 
 
 
Left =Left (Cell;#) 
 

Show the # number of signs counted from the left 
side of the indicated cell. 
 
Vänster  Links 
 
 
 

Len =Len(Cell) 
 

Counts the number of signs within a cell. Blank 
spaces are also counted. 
 
Längd  Länge 
 
 
 
 

Trim =Trim(Cell) 
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Cleans the content of a cell form unnecessary blank 
spaces. 
 
Rensa  Glätten 
 
 

 
Value =Value(Value) 
 

Convert an alpha-numerical value to a number. 
This might be the necessary when values are 
imported from external databases. The values look 
like numbers, but since they are alpha-numerical 
you may not create any formulas with them. 
 
Textnum  Wert 

 
 
 
Upper =Upper(Value) 
 

Convert lower-case letters in to upper-case letters.  
 
Useful formula if you would like to create order in 
a table with different types of cases. 
 
Versaler  Gross 

 
 
 
Lower =Lower(Value) 
 

Convert upper-case letters in to lower-case letters. 
 
Same usefulness as of the formula upper. 
  
Gemener  Klein 

 
 
 
Round =Round(Value;#) 
 

 Rounds a value/formula to a specific number of 
decimals. When we work with currency the 
number should be 2. In this way unwanted 
rounding-errors are avoided in summations. 
 
Avrunda  Runden  
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Sum =Sum(Area) 
 

Sums the numerical values in a defined area 
 
Summa  Summe 
 

 
 
Count =Count(Area) 
 

Counts the numerical values in a defined area. 
 
Antal  Anzahl 
 

 
 
CountA =CountA(Area) 
 

Counts all values in a defined area. 
 
AntalV  Anzahl2 
 

 
 
Average =Average(Area) 
 

Counts the average value of the numerical values 
in a defined area. 

 
 Medel  Mittelwert 
 
 
 
Min =Min(Area) 
 

Identifies the lowest value in a defined area. 
 
 Min  Min 
 
 
 
Max =Max(Area) 
 

 Identifies the highest value in a defined area. 
 
 Max  Max 
 
 
Median =Median(Area) 
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Identifies the middle value in a defined area. 
 
 Median  Median 
 
 
 

If =If(Condition;True;False) 
 
Checks if a condition is met and returns one value 
if it is true and another value if it is false. 
 
Om  Wenn 
 
 

 
Isna =Isna(Condition) 

 
Checks whether a value is #N/A (not applicable) 
and returns the value true if the value is missing 
and false if the value is not missing. 
  
Ärsaknad  Istnv 
 
 

 
Vlookup =Vlookup(Value;Search area;Target column; 

False) 
 

Vertical lookup 
 
Searches for a certain value in a specified area and 
returns the value in the target column. The target 
column must be within the specified area. The 
value false is used to return #N/A if the value is not 
found within the search area. 
 
Letarad  Sverweis 

 
 
 
 
 
 
 
 
 
 
 
Hlookup =Hlookup(Value; Search area;Target row;False) 
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Horizontal lookup 
 
Searches for a certain value in a specified area and 
returns the value on the target row. The target row 
must be within the specified area. The item false is 
used to return #N/A if the value is not found within 
the search area. 
 
Letakolumn  Wverweis 

 
 
 
SumIf =SumIf(Search area; Target value; Target area) 
 

Sums the values in the target area (column) when 
the search area (column) equals the target value 
 
Summa.om  Summewenn 

 
 
 
References 
 
In a formula the reference to a certain cell/area can be relative, 
absolute or mixed. 
 
Relative A reference is relative if the appointed cell changes 

when the formula is copied to another cell (A2). 
 
 Relativ referens Relativem bezug 
 
 
Absolute If the appointed cell does not change, when the 

formula is copied to another cell, the reference is 
absolute ($A$2). 

 
 Absolut referens Absolutem bezug 
 
 
Mixed A reference might be mixed relative/absolute both 

regarding the column and to the row (A$2, $A2). 
In the first case the formula always relates to row 
2. In the second case the formula always relates to 
column A. 

 
 Mixad referens Gemischetem bezug 
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The combination of relative, absolute and mixed references is 
essential when formulas are copied in a worksheet. The reason 
for this is that a relative reference always changes when it is 
copied to another cell, while an absolute reference does not 
change. It is therefore necessary to use mixed references in order 
to get some row constant while the column changes or some 
columns constant as the rows changes. 
 
To change from relative to absolute reference place the cursor in 
front of the reference and strike the F4 key once. To change to 
mixed reference, with the row reference absolute and the 
column reference relative, strike the F4 key twice. To change to 
mixed reference, with the row reference relative and the column 
reference absolute strike the F4 key three times. If the F4 key is 
struck four times the reference returns to relative. 
 
 
 
Primary key 
 
In a database there is always a need for a primary key. The 
primary key is a unique value in a field (column). If no field 
represents a unique value, a new field can be created by 
combining existing fields. For example you can combine the 
client-number with a property-number to create a unique field 
for the specific record (row). 
 

 
 
 
 
Advanced formulas 
 
Enclosed formulas 
 
A formula might be combined with other formulas. An enclosed 
formula is then created. One example of this is showed in the 
example above regarding primary key. 
 
=Value(Trim(D2)&Trim(A2)) 
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This creates a number of the trimmed values for client and 
property. 
 
 
Another example is 
 
=Value(Left(Cell;4)) 
 
This creates a value of the first four signs to left in a cell. 
 
 
A third example is 
 
=If(Isna(Vlookup(A2;K2:X100;4;False));”Missing”;”Exist”) 
 
This returns the value “Missing” if a value does not exist in a 
search-area. If the value exist the value “Exist” is returned. 
 
 
The formula might be adjusted a little bit to 
 
=If(Isna(Vlookup(A2;K2:X100;4;False));0; 
Vlookup(A2;K2:X100;4;False)) 
 
This returns a zero-value if a value does not exist in a search-
area. Otherwise the value of the fourth column in the search-area 
is returned. 
 
 
 
Paste special 
 
When a cell/area is copied and pasted into another area all the 
existing values, formulas, formats etc are replaced with the new 
values etc. 
 
There is however a method to paste only certain criteria of the 
copied cell/area into the new area. This is executed by the 
command “Paste Special”.  There are several ways of using the 
command. The full extent of the possibilities is shown in the 
dialogue-box below. 
 
Klistra in special Inhalte einfügen  
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Values Paste the values of the copied cell/area into the 

new area. All other criteria of the destination area 
remain unchanged. 

 
 Värde  Werte 
  
 
Formulas Paste the formulas of the copied cell/area into the 

new area. All other criteria of the destination area 
remain unchanged. 

 
 Formler  Formeln 
 
 
Format Paste the format of the copied cell/area into the 

new area. All other criteria of the destination area 
remain unchanged. 

 
 Format  Formate  
 
 
Operation With this operation you can add/subtract etc the 

values of the copied cell/area into the existing 
values of the new area. 

 
 Åtgärd  Vorgang 
 
 
Transpose This operation paste all the criteria of the copied 

cell/area into the new area. The values are 
however re-orientated vertically/horizontally. 

 
 Transponera Transponieren 
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Macros 
 
In Microsoft Office you can automate frequently used tasks by 
creating macros. A macro is series of commands and 
instructions that you group together as a single command to 
accomplish a task automatically.   
 
Typical uses for macros are: 
 

• To speed up routine editing and formatting 
• To open certain files 
• To combine multiple commands, for example to insert a 

table with a specific size and borders, and with a specific 
number of rows and columns 

• To automate a complex series of tasks 
 
 
You can use the macro recorder to record a sequence of actions, 
or you can create a macro from scratch by entering visual basic 
code in the visual basic editor (VBE). Recorded macros may be 
edited in the VBE. 
 
When you create macros with the recorder, you do not have to 
know any of the visual basic code. A macro is recorded by 
clicking on the button for macros in the view group and 
selecting record macro. 
 

 
 
 
A new dialogue box will appear. Give the Macro a name. Do not 
use spaces in the name. Store the macro in your personal macro 
workbook. 
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Perform the commands that you want to record. Finish the 
macro by clicking on the macro button and select stop recording. 
 

 
 
 
When you exit Excel the dialogue box below will appear. If you 
chose [Yes] the macros will be saved for future use. 
 

 
 
 
The workbook for personal macros is placed in the “Application 
Data” folder on the computer. The example below shows the 
location in Citrix.  
 

  
 
 
 
Buttons for macros 
 
To make macros more easily reachable, buttons can be created 
in the quick access toolbar. Then connect the created buttons to 
the macros. 
 

• Customize the quick access toolbar 
• Select more commands… 
• Chose commands from the Macro group and then click 

on add 
• Customize the button by selecting the button and click 

on modify. Select a button for the macro. 
• Click on OK when you are finished 
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Personal workbook 
 
Due to each individuals responsibilities, the use of Excel differs 
from user to user. Each user often has his/her own work pattern. 
This pattern can be used to create a personal workbook. 
 
One example might be a worksheet/workbook created with the 
following format: 
 

• Column width = 12 
• Row height = 15 
• Font = Times New Roman 
• Font size = 12 
• Number format = 0 000,00 

 
When the workbook is formatted save it as a excel template in 
the folder for Application Data\Microsoft\Excel\Xlstart 
 
There are two types of templates 
 
Xltx Excel template 
 
Xltm Excel macro enabled template 
 
To open the created template use Ctrl + N or click on new. 
 
 ____________ 


